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DAYANAND EDUCATION SOCIETY'S

DAYANAND COLLEGE OF PHARMACY

BARSHI ROAD, LATUR.

Computer Application

Certificate Course Objective

This course will facilitate the students to
e Know the various types of application of computers in pharmacy
* Know the various types of databases
e Know the various applications of databases in pharmacy
* Work effectively with a range of current, standard, office Productivity

software applications.
Certificate Course Highlights

e Time duration-30hours.
e Course duration from 20/12/2021 to 27/04/2022

e This course is free of cost
e (Course Co-ordinator- Ms. BUKKE R. D.
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Syllabus framing committee for certificate course on Computer Application

Academic Year 2021-22

;l(;: Name Designation Name of College
1 Dr. Satpute K.L. Principal Dayanand College of Pharmacy, Latur
2 Mr. Sonvane S.M. Academic Incharge Dayanand College of Pharmacy, Latur
3 Dr. Chaus W.N. M. Pharm Coordinator | Dayanand College of Pharmacy, Latur
4 | Ms. Bukke R.D. Subject Incharge Dayanand College of Pharmacy, Latur
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Dayanand College of Pharmacy, Latur

M. Pharmacy (2021-22)
[ COMPUTER APPLICATIONS IN PHARMACY J

30 Hrs (2 Hrs/Week)

Scope: This subject deals with the introduction Database, Database Management

system, and computer application in clinical studies and use of databases.
Objectives: Upon completion of the course the student shall be able to
1. Know the various types of application of computers in pharmacy
2. Know the various types of databases
3. Know the various applications of databas;s in pharmacy

Learning Outcomes

e Work effectively with a range of current, standard, Office Productivity software
applications. ,

e Evaluate, select and use office productivity software appropriate to a given
situation.

* Apply basic adult learning and assessment principles in the design, development,
and presentation of material produced by office productivity applications.

¢ Demonstrate employability skills and a commitment to professionalism.

® Operate a variety of advanced spreadsheet, operating system and word
processing functions.

* Solve a range of problems using office productivity applications, and adapt
quickly to new software releases.

* Maintain quality assurance through critically evaluating procedures and results.



Chapter - 1

¢ Basic Introduction Of Computer :- 4Hr
RAM. ROM, LAN, Types Of Hardware Scanning Software How To

Create Linking Profile.

Chapter - 2

e Microsoft Office :- 10Hr
1) MS Word :-Formatting Text: Importance Of Formatting, Paragraphs And
Alignment, Bold Text, Italic Text, Underline , HTML Headings, Font
Attributes, Marquee Tag And Attributes Heading Tag Links & Tables :

How Hyperlinks Work, Border E-Mail Links, And Table Tags & Table
Attributes, Tow Attributes, Cell Attributes, Merging Rows & Columns,

Font Setting.

2) MS Excel &MS PowerPoint Images:- Different Image Formats, Image
Tags And Attributes, Background Images And Color Inserting Audio And
Video Files, Images Link ,Effective Presentation By Using Power point
Calibration Curve , Calculation Technique By Using MS- Excel .

Chapter -3

e Internet & Web Designing Concepts Internet:- 8Hr
Introduction To Internet, Internet Services, WWW, Hypertext Transfer
Protocol (HTTP), URL, Web Server, Proxy Servers Web Site Concepts:
Web Page , Static And Dynamic Web Page, Web Site Development
Phases, GoogleScholar, Pub Med ,Science Direct, Research Gate, Scihub,
Drtical Searching E-mail:



Chapter -4
e Computer Application In Pharmacy:- 8Hr
Drug Design And Development Of Pharmaceutics Products Through
Optimization, Pharmaceutical Analysis, Stability, Bioequivalence,
Statistical Quality Control (SQC), Statistics And Design Of Experiments
(DOE), Validation, Diagnosis And Data Analysis,
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Ref. No.: DCOP/2021-22/39 5(1 (A Date: 17/12/2021

To,

Dr. Satpute K.L.,
Principal,
Dayanand College of Pharmacy,

Latur.

Subject: Invitation for syllabus framing committee of “Certificate course on Computer

Application and Communication Skill”.

Dear madam,

With reference to above cited subject, we are pleased to invite you as a member for syllabus
framing committee of “Certificate course on Computer Application and Communication Skill”
scheduled on dated 18/12/2021 at. 04:00 pm. with this concerned, let me take pleasure in inviting
you for member of our syllabus framing committee. We believed that your contribution to this
certificate course will be of great benefit to our college.

Kindly accept our Invitation and oblige us with confirmation.

Thanking you.
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Ref. No.: DCOP/2021-22/3 959 (A ) Date: 17/12/2021

To,

Dr. Chaus W.N,
M. Pharm Coordinator,
Dayanand College of Pharmacy,

Latur.

Subject: Invitation for syllabus framing committee of “Certificate course on Computer

Application and Communication Skill”.

Dear Sir,

With reference to above cited subject, we are pleased to invite you as a member for syllabus

framing committee of “Certificate course on Computer Application and Communication Skill”

scheduled on dated 18/12/2021 at. 04:00 pm. with this concerned, let me take pleasure in inviting

you for member of our syllabus framing committee. We believed that your contribution to this

certificate course will be of great benefit to our college.

Kindly accept our Invitation and oblige us with confirmation.

Thanking you.




~

Davanand Education Society's

DAYANAND COLLEGE OF PHARMACY,

: Barshi Road, Latur (Maharashtra) Pin - 413531 PH-(02382)-223299, 223199
Website: www. davanandpharmacv.ore E-mail : davanandpharmacy@rediffimail.com
principaldcop@gmail. com

Shri Laxmiraman Lahoti Shri Ramesh Biyani Dr. Satpute K.L.
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Ref. No.: DCOP/2021-22/84 $9(A) Date: 17/12/2021

To,

Mr. Sonvane S.M.,
Academic Incharge,
Dayanand College of Pharmacy,

Latur.

Subject: Invitation for syllabus framing committee of “Certificate course on Computer

Application and Communication Skill”.

Dear Sir,

With reference to above cited subject, we are pleased to invite you as a member for syllabus
framing committee of “Certificate course on Computer Application and Communication Skill”
scheduled on dated 18/12/2021 at. 04:00 pm. with this concerned, let me take pleasure in inviting
you for member of our syllabus framing committee. We believed that your contribution to this
certificate course will be of great benefit to our college.

Kindly accept our Invitation and oblige us with confirmation.

Thanking you.

X\«,‘p‘)\ Ol
e

"\




~

Davanand Education Society's

DAYANAND COLLEGE OF PHARMACY,

- Barshi Road. Latur {Maharashtra) Pin - 413531 PH-(02382)-223299, 223199
Website: www.davanandphannacv.org E-mail : davanandphanmacv@rediffinail.com
principaldcopi@gmail. com

Shri Laxmiraman Laboti Shri Ramesh Biyani Dr. Satpute K.L.
\ President Secretary Principal

Ref. No.: DCOP/2021-22/3 G 5§ (A } Date: 17/12/2021
To,
Ms. Bukke R.D.
Dayanand College of Pharmacy,
Latur.

Subject: Appointment as a faculty for “Certificate course on Computer Application”.

Dear Madam,

With the reference to above cited subject, you are appointed as a faculty for “Certificate
course on Computer Application”. College is going to start this certificate course from
20/12/2021. We will share a copy of Certificate course time-table with this letter. kindly accept

it and do the needful.

With warm regards.
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Notice
Date. 17.12.2021
All the students of M Pharmacy First year are here by informed that
college is going to conduct certificate course on “Computer Application” so
all students must enroll your name towards Ms. Bukke R.D. before 18/12/2021
upto 5 pm. v
Take note of the same. .

Princi
rmcha]l
ayanand College Of Pharmacy



Dayanand Education Society's

DAYANAND COLLEGE OF PHARMACY,

Barshi Road, Latur (Maharashtra) Pin - 413531 PH-(02382)-223299, 223199
Website: www.dayanandpharmacy.org E-mail : dayanandpharmacy@rediffinail.com
principaldcop@gmail.com Y,

Notice
Date. 18.12.2021
All the students of M Pharmacy First year registered for certificate
course on “Computer Application” are hereby informed that, the certificate
course is going to start from 20/12/2021 according to timetable.
Take note of the same.

.

Principal
Princip‘a.r
Dayanand College Of Pharmacy
LATUR
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c S Time ~table for Odd Semester
Academic Year: 2021-22 Pattern: & POl
Class: M Pharmacy 1" year (Semester-1) Hall Ng:-02
Subject:- Pharmaceutical Quality Assurance W.EF:-
‘ : i 340 1% 31
" i) - oMY . s43} . PeHb . 1R i
Dav/Time 4900 R ] 11:60 12:00 164 Z f2: 14:00 G500
s 10:00 | 11:00 | 12:00 | 05:00 0200 0300 o
- S/A CA MPAT OMS | LOOMS A
o GAR RE GAF SHN - SBM M HR
Aty GAB BRD AB SBM i BM  RTM
i S/A CA MPAT  QMS U | QAQC | OQMS
— SBM | BRD | GAB | SBM N | RIM | sBM  HRI
to »
o S/A PDTT | MPAT CS H POTT | QAQC &
Wednesday SBM HRU GAR Kep HRU RTM™ R’
T )
o S/A €S | MPAT | PDIT | QAQC | PDTT | S'A
Thursday GAB kKPP | GAB  HRU ! RTM | HRU | RIM

(02 1o 06 pm) PQA-T -SKI
{Practical)

Friday (10:00 to 02:00 pm) PQA-1 -SKL (Practical) E
Saturday | (10:00 to 02:00 pm) PQA-I -SKL (Practical}

Activity Day

Sr.No

Name of faculty

Subject Name

01

Dr. Satpute K.L. (SKL)

Pharmaceutical Quality assurance-1 (POA-D)

02

Mr. Gadgul A.B. (GAB)

Modermn Pharmaceutical Analytical Techniques { MPAT)

03

Mr. Shetkar 5.M.{ SBM)

Quality Management Svstem (QMS)

04

Ms. Rajmanya T.M. ( RTM)

Quality Control and Quality Assurance { QA & QC)

05

Mr. Hude R.U. ( HRU)

Product development & Technology Transfer (PDTT) T

i)

06

Ms. Buke R.D. (BRD})

Computer Application (CA)

07 | Ms. Khanapure P.P.(KPP) | Communication Skill(CS) ]
08 Seminar / Assignment ( S/A)
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Time ~table for Odd Semester
Academic Year: 2021-22 Pattern: - PCI

Class: M .Pharmagy ¥ vear (Semester-1) Fiall No:0

Subject:- Pharmaceutics W.E.F:- 2 /1272021

Dl 09:00 | 10:00 | 11:00-  12:00- | 01:00-  02:00-  03:00- 04:00
Ay Lme | 10:00 11:00 12:00 | 01:00 | 02:00 0300 04:00 03:00
fonday | A CA | MPAT | RA pDDS | MP | s
onday 1 GaB BRD GAB SRR TSS CWN 18
| |
- S/A CA MPAT | DDS u MP RA
i CWN BRD GAB TSS N CWN SRR
{: ......
rodneeday | | WP S/A MPAT CS H RA | DDS  SA
Veduenbey | owy SRR GAB | KPP SRR TSS | CWN
T |
o 1os/A S MPAT | MP 1 pDS  RA S/A
Thursday | Gap | Kpp | GAB | CWN | M | TSS SRR SRR
Friday | (10:00 to 02:00 pm) PP-A - TSS(Practical) | (021006 pm) PP-A-TSS
‘ (Practical) R
b Saturday | (10:00 to 02:00 pm) PP-A-TSS (Practical) | § Activity Day
Sr.No Name of faculty Subject Name

01 Dr. Chaus W.N. (CWN) | Modern Pharmaceutics ( MP)
02 Dr. Tiwari 8.5. (TS85) Drug Delivery System (DDS)
03 Mr. Gadgul A.B. (GAB) Modern Pharmaceutical Analytical Techniques { MPAT)

04 Mr. Sarda R.R. (WRS) Regulatory affairs { RA)
05 | Dr. Tiwari S.S. (TSS) Pharmaceutics Practical 1 (PP-I) )
06 | Ms. Buke R.D. (BRD) Computer Application (CA) M
07 | Ms. Khanapure P.P.(KPP) | Communication Skill(CS) i
06 Seminar / Assignment { $/A) 1

Q™ o

Academic Incharge Co-ordinator
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CERTIFICATE COURSE ON “Computer Application”

REGISTRATIONFORM (2021-22)

Name of Student : \<‘ao% m k?jgew’)a  Ba \v\POm

Class S ha B ?haﬁma ’a'[# <002 ( ’O}MSMQC@A?‘( 5)
City : /,y\'u Z.
Contact No. : qq‘é,s"{&, ’50<

E-mail. ’40\ Opd fes) IOPJ fﬂﬂ?a L @ d'ma L } Com
Career Aim : /ﬁ) O(‘,a eyve o fb‘_&/ﬁ 20 'R:)Q [)
@Pﬁa Q/Qm@n')[ CLO

Undertaking —I hereby undertake that I shall attend the classes regularly without fail and
participate in all activities conducted during sessions.

Candidates Signature

S &

Ms. Bukke R.D Dr. Satpute K.L.
Course Co-ordinator Principal
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List of Student Enrolled for Certification Course on Computer

Application Academic Year 2021-22

M. Pharm — Ist Year Pharmaceutics

Roll No. Name of Student
1 Chavan Pavan Bharat
2 Dalal Pramod Shivanand
3 Eklinge Shweta Shivraj
4 Gaikwad Megha Virsen
> | Gutte Vaishali Pundlik
6 Hole Ajay Ramdasrao
7 Kadam Krishna Baliram
8 Kote Narayan Rajaram
9 Mane Sayali Dadasaheb
10 Mujawar Muskan Dildar
11 Pande Bhagyashree Nagorao
12 Sabane Anjali Ambadas
13 | Shaikh Muskan Ajaz
14| Solat Shraddha Adinath
15 Surwase Pratiksha Suresh
16 Swami Deepali Mallikarjun
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List of Student Enrolled for Certification Course on Computer

Application Academic Year 2021-22

M. Pharm — Ist Pharmaceutical Quality Assurance

Roll No. Name of Student
! Delmade Swapnali Shivaji
2 Gatate Mayuri Satishappa
3 Ghotmukle Rohini Ashokrao
“ Kale Pooja Prabhakar
> Kauthekar Pranav Venkat
B Palskar Bhushan Anandrao
7 Rahatkar Saurabh Sainath
¢ Rudrawar Aishwarya Santosh
? Sakhare Sushant Digambar
1¢ Shinde Dipak Narsing
1 Thengil Bhushan Tukaram
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Attendance Sheet F&m ﬂﬁ.ﬁ% Q&@ Oj Q é@@ %ﬂ%ﬂ.ﬂ‘m&dﬁﬁﬁ Year 2021-22

Roll Niiniie of Student 201220 911221 D1-10-2| 98 1020 - 01-07 41-01-22] Vo - 0127 44-01-22) 18-01-29 2.4.01-22|25 -0 1-29] B1-01-29] 1 -070.-2Y =1-02-22| 1 5.0 29

i L [ [ e i L o O e e Lt

1 |Chavan Pavan Bharat

J— — §
2 |Dalal Pramod Shivanand po—| Lo | A |k @E\@P&\ @ §1> % %@ M@ @Wy %\\
3 [Eklinge Shweta Shivraj Q@?c %&@@& @w&\\ @»@N\\@\c\(\ A % @&@@m&w \@%% \§o\% @M% A @\%
4 |Gaikwad Megha Virsen nﬂ@\oy %&//@ %@@%@ A@@v/@ %@% ,mnowv/(o/ %Aﬁc&/&:ﬁﬂm\wﬂ@ %@%@% n»/@%/? A%W?/%y n»/@w%/
5 |Gutte Vaishali Pundlik Qo | ¥ | R | ¥ | oV 0| K L@o¥ | ot X OV | SO |38 |7 | \
6 |Hole Ajay Ramdasrao {\\‘l%%*% @V\ &% A &% &,\ —r @ev\ A
7 |Kadam Krishna Baliram f\l\\\\l\\\\\k% Wg \% A . n@@\ .mg Q\ n@\ \%\
8 |Kote Narayan Rajaram % %%@@%% % A %%%A\@% /@O& %%
9 |Mane Sayali Dadasaheb (\A\@@ P A@K %‘)\\\@@ @M@@ @ A
10 |Mujawar Muskan Dildar — Egg Mwﬂuﬁgg e ? rQ,\«»Nmrn_: gg gu
11 |Pande Bhagyashree Nagorao ] m\% w‘\% mm%k m‘@\% \W\@&c ammm\@ A E & W&é
12 [Sabane Anjali Ambadas i@@%g&w 7 m@ﬂ%@w@\ﬂ@@%» P
13 |Shaikh Muskan Ajaz @v@“,@“@u\\%@wu A CL\@H@H@H,@U A @H@N
14 |Solat Shraddha Adinath — BudiRQuet| A |Boud@alli @itk A %@%\« (Rplok| Ak R Aok | Rdak
15 |Surwase Pratiksha Suresh g &%\% @\ A ‘A\%%E\@W\@%\ %% % ?
16 |Swami Deepali Mallikarjun ] @,\Y\Q&ME% ME‘%\ @m&ﬁm@ \Mwmwwoa A m@%ﬁ\gﬁéﬁ @nﬁé@
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cetti¥ical® Coutse. on Compulet. Applicalion

M. Pharmacy first Year 2021-22

Roll

) 23- S.s_. 1-69-22]

Shaikh Muskan Ajaz

2

Solat Shraddha Adinath

Be

Surwase Pratiksha Suresh

P

No. Name of Student YURDE 7-022% R .0522| 14.00-2 + 5-0322| ng.08-2) n00-2% 2004 | N3-0y22] 4-ou-
1 |Chavan Pavan Bharat _uscksn\ ﬁ%. % gk\\@t\&ﬁ«%\.ﬁ w% m%r ‘%g ghwhu ﬂ:bx\n\ § Yeu2e.
2 |Dalal Pramod Shivanand m&wp @&\ @@ P @\ @n@ g\ @\%% %@\%w@\
3 |Eklinge Shweta Shivraj @\F@w m@{\ @k AN @\\ @N\@%%% A § &@u&«@&. @%&
4 |Gaikwad Megha Virsen %%/9 P %o@pg 2/@&7@»2% %? P 7 ? 2&( i _%c\%%/@ nﬁ%v//@f 2@%/9%//9 %4/9
5 |Gutte Vaishali Pundlik B [Ra oY |\ [ [ | A | ) e | &e¥ [ | S| et R
6 |Hole Ajay Ramdasrao %\\@mﬂ» M_\W&\ A % %\ A &Wx %\ % &B\\N&w %v %\%)
7 |Kadam Krishna Baliram P n@&\n@\@@ %\@x b« | \P@ @ @@w
8 |Kote Narayan Rajaram ? WO A/@W%A\OV@\DA\@V«% Y % % % 7 Q\Vm\ﬁfm@v . % @0\ %
9 [Mane Sayali Dadasaheb @\,@\/ @D P m@.} @L @ @\ \% m%b\/s %\/ @7\\‘ @\/ %
10 [Mujawar Muskan Dildar E P EEE% Bkl Eﬁggg R oo
11 |Pande Bhagyashree Nagorao E m&%\ &m @m \m‘mﬁm@u AW\»\[%D D Vﬁ.&t&:@ m&:& g \g EE
12 |Sabane Anjali Ambadas %@%@% @@Wé%@%n
s GF I
% @evbw @% @o\/%u @6&.

Swami Deepali Mallikarjun
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Quality Assurance
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Delmade Swapnali Shivaji
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Gatate Mayuri Satishappa
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Ghotmukle Rohini Ashokrao
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20

Kale Pooja Prabhakar
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21

Kauthekar Pranav Venkat
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22

Palskar Bhushan Anandrao

A

5

23

Rahatkar Saurabh Sainath

24

Rudrawar Aishwarya Santosh

e

25

Sakhare Sushant Digambar

D

P
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26

Shinde Dipak Narsing

27

Thengil Bhushan Tukaram
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Quality Assurance
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Ghotmukle Rohini Ashokrao

Kale Pooja Prabhakar

21 |Kauthekar Pranav Venkat

\

22

Palskar Bhushan Anandrao

23

Rahatkar Saurabh Sainath
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24

Rudrawar Aishwarya Santosh

Sakhare Sushant Digambar

26 |Shinde Dipak Narsing

Thengil Bhushan Tukaram

=R [E
bslols B SR e

S

Rk el IE

HENEEEECR S

dENiteniaEs i

SN R L

> &gl Rl | ¢
oo oo B o S| s

bl

ool N R

el e el e
e o | 3P| R

T e e

e [E T Y




f/ Davanand Fducation Society's

\‘ principaldeop@gmail.com )

Ve DAYANAND COLLEGE OF PHARMACY,
Barshi Road. Latw (Maharashtra) Pin - 413531 PH-(02382)-223299, 223199
Website www davanandpharmacy.org Femail : davanandpharmacy(@rediffinail. com

Date: 24/03/2022

Time-Table For Second Sessional Theory Exam Academic Year 2021-22

For M. Pharm I* vear (SEM-1) Pharmaceutical Quality Assurance

Subject Time
Sem-1 Theory/Practical

Sr.No Date

Modern Pharmaceutical Analytical

! 28/03/2022 - o 11:00 am to 12:00 pm
I'echniques

2 29/03/2022 Quality Management System 11:00 am to 12:00 pm

3 300032022 Quality Control and Quality 11:00 am to 12:00 pm

Assurance

Product Development and Technology

~ 10372022 "
4 31/03/20 Transfer

11:00 am to 12:00 pm

L 01/04/2022 Pharmaceutical Quality Assurance
: T (Practical I)

W

10:00 am to 05:00 pm

6 04/04/2022 Computer Application ( Theory ) 11:00 am to 12:00 pm

7 04/04/2022 Communication Skill ( Theory) 03:00 pm to 04:00 pm

T .
,\\’._){C.‘

» Theory Exam will be conducted through online mode (Vmedulife).

> Practical exam will be conducted through offline mode.

aﬁ»xam Incharge 'gﬁ?’t ala'

(. DY. S i \«Mu) Dayanand College of Pharmesy
LATUR



Dayanand Education Society's
v DAYANAND COLLEGE OF PHARMACY,
. Barshi Road. Latur (Maharashtra) Pin - 413531 PH-(02382)-223299. 223199
Website: www dayvanandpharmacy.org E-mail : dayanandpharmacy@rediffinail.com
\_ principaldecop@gmail.com ¥
Date: 31/01/2022
Time-Table For First Sessional Theory Exam Academic Year 2021-22
For M. Pharm I" vear (SEM-I) Pharmaceutical Quality Assurance
; SN | Datc Suh‘gecf " Time
o ae Sem-1 Theory/Practical
@ 1 08/02/2022 Modern Pll&l?]lﬁC?llilCZﬂ Analytical 11:00 am to 12:00 pm
Techniques
2 09/02/2022 Quality Management System 11:00 am to 12:00 pm
3 10/02/2022 Unality wontrel And Quatity 11:00 am to 12:00 pm
Assurance
4 11022022 Product Develq}?mcm and Technology 11:00 am to 12:00 pm
Transfer
| s | 12/0272002 | ‘FPharmaceutical Quality Assurance | 6.0 011 16 05:00 pm
§ {Practical )
6 14/02/2022 Computer Application ( Theory ) 11:00 am to 12:00 pm
7 14/02/2022 Communication Skill ( Theory) 03:00 pm to 04:00 pm
Note:-

» Theory Exam will be conducted through online mode (Vmedulife).

» Practical exam will be conducted through offline mode.

Dr. Satpute Kranti Limbajireo
Principal

pavanand College Of Pharmacy
" LATUR




Dayanand Lducation Society's

¥ Y L A kA1 o
DAYANAND COLLEGE OF PHARMACY,
Barshi Road. Lanr (Maharashtra) Pin - 413531 PH~(02382)-223299. 223199
Website: www.dayanandpharmacy.org E-mail : dayanandpharmacy@rediffinail.com

\ principaldeop@amail.com j
Date: 26/04/2022

NOTICE

All the students of M. Pharmacy first year are here by informed that, there is
external home examination for Computer application and Communication Skill on
27/04/2022 on Vmedulife software. It is compulsory to attend the examination. If
you remain absent your final result will not be displayed. Time table for the

examination is displayed follow.

Sr. No Name of Subject Date Time

s

Computer Application | 27/04/2022 10:00 am to 12:00 pm.

Communication Skill | 27/04/2022 03:00 pm to 05:00 pm

(3]

Take a note of the same.

Exam Inc rge Princﬁ{
(m Qac Principal
Uayanand College of Fnarmacy
LATUR



Dayanand Education Society’s, Dayanand College of

Pharmacy, Latur

Pharmaceutical Quality Assurance [2021-22]
Title : Computer Application ( First Sessional Exam 2021-2022)
Subject : Computer Application - Theory
Faculty : Ms. R. D. Buke
Year : First Year - First Semester
Date : Mon 14 Feb, 2022
Marks : 30
Duration : 60 Minutes

1] Question : MS excel is used for creating which of the following? [Single Correct] [1 Marks]
1) Presentations

2 ) Dcouments

3 ) Sending mails

4 ) @Spreadsheets

Explanation :

Bloom's Level: Remember

2] Question : Which of the following is not a font style ? [Single Correct] [1 Marks]
1) Bold

2 ) @Superscript

3) ltalic

4 ) Regular

Explanation :

Bloom's Level: Remember

3] Question : Minimum number of rows and columns in MS Word document is [Single Correct] [1 Marks]

1)®1and 1
2)2and1
3)1and?2
4)2and?2
Explanation :

4] Question : PowerPoint presentations are widely used as [Single Correct] [1 Marks]
1) Note outlines for teachers

2 ) project presentations by students

3 ) Communication of planning

4 ) @Al of above

Explanation :



5] Question : A new presentation can be created from [Single Correct] [1 Marks]
1) Blank presentation

2 ) From Existing Presentation

3 ) From Design Template

4 ) @Al of above

Explanation :

6] Question : From which menu you can access Picture, Test Box, Chart etc.? [Single Correct] [1 Marks]
1) File

2 ) Edit

3 ) ©@Insert

4) View

Explanation :

Bloom's Level: Remember, Create

7 ] Question : Special effects used to introduce slides in a presentation are called [Single Correct] [1
Marks]

1) effects

2 ) custom animations

3 ) @transitions

4 ) present animations

Explanation :

8] Question : The ____ feature of MS Excel quickly completes a series of data [Single Correct] [1 Marks]
1) Auto Computer

2 ) @Auto Fill

3 ) Fill handle

4 ) Sorting

Explanation :

9 ] Question : The basic unit of a worksheet into which you enter data in Excel is called a [Single
Correct] [1 Marks]

1)®@Cell

2 ) Table

3 ) Box

4 ) Column

Explanation :

Bloom's Level: Remember

10 ] Question : How many sheets are there, by default, when we create a new Excel file ? [Single
Correct] [1 Marks]

1)1

2)10

3)4

4)©@3

Explanation :

Bloom's Level: Remember, Create



11 ] Question : It is a collection of data that is stored electronically as a series of records in a table.

[Single Correct] [1 Marks]
1) Spreadsheet

2 ) Presentation

3 ) @Database

4 ) MS Word
Explanation :

12] Question : The brain of the computer system is which of the following? [Single Correct] [1 Marks]
1)ALU

2)®@CPU

3 ) Memory

4 ) Control Unit

Explanation :

Bloom's Level: Remember

13 ] Question : What type of device is computer keyboard? [Single Correct] [1 Marks]
1) Memory

2 ) Output

3 ) Storage

4 ) @lnput

Explanation :

Bicom's Level: Remember

14] Question : Verification of a login name and password is known as: [Single Correct] [1 Marks]
1) Configuration

2 ) Accessibility

3 ) @Authentication

4 ) logging in

Explanation :

Bloom's Level: Remember

15 ] Question : The primary memory (also called main memory) of a personal computer consists of
[Single Correct] [1 Marks]

1) RAM only

2 ) ROM only

3 ) ©both RAM and ROM

4 ) Cache memory

Explanation :

16 ] Question : The Boot sector files of the system are stored in which computer memory? [Single
Correct] [1 Marks]

1) RAM

2 ) ©ROM

3 ) Cache

4 ) Register



Explanation :
Bloom's Level: Remember

17 ] Question : Which of the following statements are not correct about the main memory of a
computer? [Single Correct] [1 Marks]

1) In main memory, data gets lost when power is switched off.

2 ) Main memory is faster than secondary memory but slower than registers.

3 ) They are made up of semiconductors.

4 ) @Al are correct

Explanation :

Bloom's Level: Remember

18 ] Question : What is the full form of RAM? [Single Correct] [1 Marks]
1) Read Access Memory

2 ) Random Access Memory

3 ) Readable Access Memory

4 ) ®Random Accumulator Memory

Explanation :

Bloom's Level: Remember

19 ] Question: RAMis_ _ and __ . [Single Correct] [1 Marks]
1) © volatile, temporary

2 ) non-volatile, temporary

3 ) volatile, permanent

4 ) non-volatile, permanent

Explanation :

20 ] Question : Which of the following memory is non-volatile? [Single Correct] [1 Marks]
1) RAM

2 ) ©®ROM

3 ) Cache

4 ) ROM and Cache

Explanation :

Bloom's Level: Remember

21] Question : Which of the following has the fastest speed in the computer memory hierarchy?
[Single Correct] [1 Marks]

1) Cache

2 ) ©Register in CPU

3 ) Main memory

4 ) Disk cache

Explanation :

Bloom's Level: Remember

221 Question : Microsoft word is software. [Single Correct] [1 Marks]
1) @Application



2 ) Compiler

3 ) System

4 ) Programming
Explanation :

23] Question:___ cannot be used to work in MS Office. [Single Correct] [1 Marks]
1) @Joystick

2 ) Scanner

3 ) Light Pen

4 ) Mouse

Explanation :

24 ] Question: The ____ works with the standard Copy and Paste commands. [Single Correct] [1 Marks]
1) View tab

2 ) Paragraph dialog box

3 ) ©Office Clipboard

4 ) All of these

Explanation :

25] Question : Which of the following is an example of page orientation? [Single Correct] [1 Marks]
1) © Landscape

2 ) Subscript

3 ) Superscript

4)A4

Explanation :

Bloom's Level: Remember

26] Question : Which of the following software is used for making resume? [Single Correct] [1 Marks]
1) MS Excel

2 ) ©MS Word

3)DevC

4 ) Java

Explanation :

Bloom's Level: Remember

27] Question : Press _____ to open the help window in MS word document. [Single Correct] [1 Marks]
1) ©F1

2)F2

3)F9

4)F11

Explanation :

28 ] Question : Select all the text in MS Word document by [Single Correct] [1 Marks]
1)Ctrl +S

2 ) Ctrl+1

3)@cCtrl+ A



4) Ctrl+ V
Explanation :
Bloom's Level: Evaluate

29 ] Question : The name of a word document displays in _ [Single Correct] [1 Marks]
1) Ribbon

2 ) @Title bar

3 ) Status bar

4 ) Home tab

Explanation :

Bloom's Level: Remember

30] Question : Times new Roman, Cambria, Arial are the example of [Single Correct] [1 Marks]
1) ©Font face

2 ) Clipart

3 ) SmartArt

4 ) Themes

Explanation :

Marks distribution as per Bloom's level

Bloom's Linked Marks  Percentage
Level Question Count

Create 2 2 6.67
Evaluate 1 1 3:33
Analyze 0 0 0.00

Apply 0 0 0.00
Understand 0 0 0.00
Remember 16 16 53.33

NOTE : Percentage for each Bloom's level is calculated using following formula

Percentage = ( Marks per Bloom's level / Total marks of all questions ) * 100



Dayanand Education Society's, Dayanand College of

Pharmacy, Latur

Pharmaceutics [2021-22]
Title : Computer Application ( First Sessional Exam 2021-2022)
Subject : Computer Application - Theory
Faculty : Ms. R. D. Buke
Year : First Year - First Semester
Date : Mon 14 Feb, 2022
Marks : 30
Duration : 60 Minutes

11 Question : MS excel is used for creating which of the following? [Single Correct] [1 Marks]
1) Presentations

2 ) Dcouments

3 ) Sending mails

4 ) ©@Spreadsheets

Explanation :

Bloom's Level: Remember

2] Question : Which of the following is not a font style ? [Single Correct] [1 Marks]
1) Bold

2 ) @Superscript

3) ltalic

4 ) Regular

Explanation :

Bloom's Level: Remember

3] Question : Minimum number of rows and columns in MS Word document is [Single Correct] [1 Marks]

1)®1and 1
2)2and1
3)1and2
4)2and?2
Explanation :

4] Question : PowerPoint presentations are widely used as [Single Correct] [1 Marks]
1) Note outlines for teachers

2 ) project presentations by students

3 ) Communication of planning

4 ) @Al of above

Explanation :



5] Question : A new presentation can be created from [Single Correct] [1 Marks]
1) Blank presentation

2 ) From Existing Presentation

3 ) From Design Template

4 ) @AIl of above

Explanation :

6] Question : From which menu you can access Picture, Test Box, Chart etc.? [Single Correct] [1 Marks]
1) File

2 ) Edit

3 ) @lnsert

4 ) View

Explanation :

Bloom's Level: Remember, Create

7] Question : Special effects used to introduce slides in a presentation are called [Single Correct] [1
Marks]

1) effects

2 ) custom animations

3 ) @transitions

4 ) present animations

Explanation :

8] Question : The ____ feature of MS Excel quickly completes a series of data [Single Correct] [1 Marks]
1) Auto Computer

2 ) @Auto Fill

3) Fill handle

4 ) Sorting

Explanation :

9] Question : The basic unit of a worksheet into which you enter data in Excel is called a [Single
Correct] [1 Marks]

1)®@Cell

2 ) Table

3 ) Box

4 ) Column

Explanation :

Bloom's Level: Remember

10 ] Question : How many sheets are there, by default, when we create a new Excel file ? [Single
Correct] [1 Marks]

1)1

2)10

3)4

4)©@3

Explanation :

Bloom's Level: Remember, Create



11] Question : It is a collection of data that is stored electronically as a series of records in a table.
[Single Correct] [1 Marks]

1) Spreadsheet

2 ) Presentation

3 ) ©Database

4 ) MS Word

Explanation :

12 ] Question : The brain of the computer system is which of the following? [Single Correct] [1 Marks]
1)ALU

2)Y©CPU

3 ) Memory

4) Control Unit

Explanation :

Bloom's Level: Remember

13 ] Question : What type of device is computer keyboard? [Single Correct] [1 Marks]
1) Memory

2 ) Output

3 ) Storage

4 ) @Input

Explanation :

Blcom's Level: Remember

14 ] Question : Verification of a login name and password is known as: [Single Correct] [1 Marks]
1) Configuration

2 ) Accessibility

3 ) @Authentication

4 ) logging in

Explanation :

Bloom's Level: Remember

15] Question : The primary memory (also called main memory) of a personal computer consists of
[Single Correct] [1 Marks]

1) RAM only

2 ) ROM only

3 ) ©both RAM and ROM

4 ) Cache memory

Explanation :

16 ] Question : The Boot sector files of the system are stored in which computer memory? [Single
Correct] [1 Marks]

1) RAM

2 ) OROM
3 ) Cache
4 ) Register



Explanation :
Bloom's Level: Remember

17 ] Question : Which of the following statements are not correct about the main memory of a
computer? [Single Correct] [1 Marks]

1) In main memory, data gets lost when power is switched off.

2 ) Main memory is faster than secondary memory but slower than registers.

3 ) They are made up of semiconductors.

4 ) @Al are correct

Explanation :

Bloom's Level: Remember

18 ] Question : What is the full form of RAM? [Single Correct] [1 Marks]
1) Read Access Memory

2 ) Random Access Memory

3 ) Readable Access Memory

4 ) ®Random Accumulator Memory

Explanation :

Bloom's Level: Remember

19 ] Question : RAMis _ _ _ _ _ _ and _ . [Singie Correct] [1 Marks]
1) @ volatile, temporary

2 ) non-volatile, temporary

3 ) volatile, permanent

4 ) non-volatile, permanent

Explanation :

20 ] Question : Which of the following memory is non-volatile? [Single Correct] [1 Marks]
1) RAM

2 ) OROM

3 ) Cache

4 ) ROM and Cache

Explanation :

Bloom's Level: Remember

21] Question : Which of the following has the fastest speed in the computer memory hierarchy?
[Single Correct] {1 Marks]

1) Cache

2 ) ©Register in CPU

3 ) Main memory

4 ) Disk cache

Explanation :

Bloom's Level: Remember

22 ] Question : Microsoft word is software. [Single Correct] [1 Marks]
1) @Application



2 ) Compiler

3 ) System

4 ) Programming
Explanation :

23] Question : ___ cannot be used to work in MS Office. [Single Correct] [1 Marks]
1) @Joystick

2 ) Scanner

3 ) Light Pen

4 ) Mouse

Explanation :

24 ] Question : The ___ works with the standard Copy and Paste commands. [Single Correct] [1 Marks]
1) View tab

2 ) Paragraph dialog box

3 ) ©Office Clipboard

4 ) All of these

Explanation :

25] Question : Which of the following is an example of page orientation? [Single Correct] [1 Marks]
1) @ Landscape

2 ) Subscript

3 ) Superscript

4) A4

Explanation :

Bioom's Level: Remember

26 ] Question : Which of the following software is used for making resume? [Single Correct] [1 Marks]
1) MS Excel

2 ) ©MS Word

3)DevC

4 ) Java

Explanation :

Bloom's Level: Remember

27 ] Question : Press ____ to open the help window in MS word document. [Single Correct] [1 Marks]
1) ©F1

2)F2

3)F9

4)F11

Explanation :

28 ] Question : Select all the text in MS Word document by [Single Correct] [1 Marks]
1) Ctrl +S

2 ) Ctri+ 1

3)@Ctrl+ A



4 ) Ctrl+V
Explanation :
Bloom's Level: Evaluate

29 ] Question : The name of a word document displays in _ [Single Correct] [1 Marks]
1) Ribbon

2 ) @Title bar

3 ) Status bar

4 ) Home tab

Explanation :

Bloom's Level: Remember

30] Question : Times new Roman, Cambria, Arial are the example of [Single Correct] [1 Marks]
1) @Font face

2 ) Clipart

3 ) SmartArt

4 ) Themes

Explanation :

Marks distribution as per Bloom's level

s
it
2}
i

;
i
paks

Bloom's Linked Marks  Percentage
Level Question Count
Create 2 2 6.67
] Evaluate 1 | 1 3.33
Analyze 0 0 0.00
Apply o 0 0.00
| Understand 0O 0 0.00
Remember 16 16 53.33

NOTE : Percentage for each Bloom's level is calculated using following formula

Percentage = ( Marks per Bloom's level / Total marks of all questions ) * 100



Dayanand Education Society's, Dayanand College of

Pharmacy, Latur

Pharmaceutics [2021-22]
Title : Computer Application (Second Sessional Exam 2021-2022)
Subject : Computer Application - Theory
Faculty : Ms. R. D. Buke
Year : First Year - First Semester
Date : Mon 04 Apr, 2022
Marks : 30
Duration : 60 Minutes

1] Question : Search engine are used to [Single Correct] [1 Marks]

1) Software system that is designed to search for information on the World Wide Web
2 ) Search Documents

3 ) Search Videos

4) @Al of these

Explanation :

Bloom's Levei: Remember, Understand

2] Question : which is the short cut key of highlight the entire column [Single Correct] [1 Marks]
1)Ctrl+ C

2 ) Cirl+Enter

3 ) Ctri+ Page up

4 ) @Ctrl+ Space bar

Explanation :

Bloom's Level: Remember

3 ] Question : In the formula, which specifies the fixed columns or row? [Single Correct] [1 Marks]
1)©$

2)*

3)&

4)%

Explanation :

Bloom's Level: Remember, Understand

4] Question : Excel displays the current cell address in the [Single Correct] [1 Marks]
1) Formula bar

2 ) status bar

3 ) ©Name bar

4 ) Title bar

Explanation :



5] Question : Which of the following is not a term of Ms- Excel? [Single Correct] [1 Marks]
1) Cell

2 ) Columns

3 ) Row

4 ) @Documents

Explanation :

Bloom's Level: Remember

6] Question : What are the tabs that appear at the bottom of each workbook called? [Single Correct] [1
Marks]

1) Reference tabs

2 ) position tabs

3 ) Location tabs

4 ) @Sheet tabs

Explanation :

Bloom's Level: Remember

7] Question : The Cancel and Enter buttons appear in the {Single Correct] [1 Marks]
1) Title bar

2 ) @Formula bar

3 ) Menu bar

4 ) Sheet bar

Explanation :

8] Question : You can activate a cell by [Single Correct] [1 Marks]
1) Pressing the tab key

2 ) Clicking the cell

3 ) Pressing an arrow key

4 ) @Al of the above

Explanation :

9] Question : Ho do you inserts a row? [Single Correct] [1 Marks]

1) @Right-click the row heading where you want to insert the new row and select Insert from the
shortcut menu

2 ) Select the row heading where you want to insert the new row and select Edit >Row from the menu

3 ) Select the row heading where you want to insert the new row and click the Insert Row button on the
standard toolbar

4) All of the above

Explanation :

10 ] Question : How can you print three copies of a workbook? [Single Correct] [1 Marks]

1) Select File > Properties form the menu and type 3 in the Copies to print text box

2 ) @Select File > Print from the menu and type 3 in the Number of copies text box

3)) Click the Print button on the standard toolbar to print the document then take it to Kinko’s and have 2 more
copies made

4 ) Press Ctrl+P+3



Explanation :
Bloom's Level: Remember

11] Question : How do you delete a Column? [Single Correct] [1 Marks]

1) Select the column heading you want to delete and select the Delete Row button on the standard toolbar
2 ) Select the column heading you want to delete and select Insert Delete from the menu

3 ) Select the row heading you want to delete and select Edit>Delete from the menu

4 ) @Right click the column heading you want to delete and select delete from the shortcut menu
Explanation : '

Bloom's Level: Remember, Create

12 ] Question : Which of the following is correct meaning of URL? [Single Correct] [1 Marks]
1) User Requisition Link

2 ) @Uniform resource locator

3 ) Uniform requisition link

4 ) Uniform resource language

Explanation :

Bloom's Level: Remember

13 ] Question : Which one of the following is not a search engine? [Single Correct] [1 Marks]
1) Bing

2 ) Google

3 ) Yahoo

4 ) ©@Windows

Explanation :

Bloom's Level: Remember, Understand

14 ] Question : Full form of HTML is: [Single Correct] [1 Marks]
1) ©Hyper Text Markup Language

2 ) Hyper Text Manipulation Language

3 ) Hyper Text Managing Links

4 ) Hyper Text Manipulating Links

Explanation :

15] Question : Moving from one website to another is called : [Single Correct] [1 Marks]
1) Downloading

2 ) ©Browsing

3 ) Uploading

4 ) Attachment

Explanation :

16 ] Question : In which view Headers and Footers are visible? [Single Correct] [1 Marks]
1) Normal View

2 ) Page Layout view

3 ) ©Print Layout View

4 ) Draft View



Explanation :
Bloom's Level: Remember

17 ] Question : Which functioning Excel checks whether a condition is true or not ? [Single Correct] [1
Marks]

1) SUM

2 ) COUNT

3)QIF

4 ') AVERAGE

Explanation :

Bloom's Level: Remember

18 ] Question : Symbol used at the beginning of the HREF text is [Single Correct] [1 Marks]
1)@#

2)%

3)&

4\

Explanation :

19 ] Question : Which of the following is a correct format of Email address? [Single Correct] [1 Marks]
1) name@website@info

2 ) ©®name@website.info

3 ) www.nameofebsite.com

4 ) name.website.com

Explanation :

Bloom's Level: Remember

20 ] Question : A Web page is. [Single Correct] [1 Marks]
1) Made up of text and HTML tags

2 ) marked by an opening HTML tag <HTML>

3 ) marked by closing HTML tag</HTML>

4 ) @All of these

Explanation :

21] Question : Which protocol provides e-mail facility among different hosts? [Single Correct] [1 Marks]
1)FTP

2 ) @QSMTP

3 ) TELNET

4 ) None of these

Explanation :

Bloom's Level: Remember, Understand

22 ] Question : in how many generation a computer can be classified [Single Correct] [1 Marks]
1)8 ¢

2)4

3)©®5



4)6
Explanation :
Bioom's Level: Remember, Understand

23] Question : The file extenction of Ms-word documents in office 2007 is------ [Single Correct] [1 Marks]
1) doc

2 ) @docx

3) .pdf

4 ) txt

Explanation :

Bloom's Level: Remember, Understand

24 ] Question : which of the following section does not exist in a slide layout? [Single Correct] [1 Marks]
1) Titles

2 ) Lists

3 ) Charts

4 ) @Animations

Explanation :

Bloom's Level: Remember, Understand

Q

25] Question : Which of following is the default page setup orientation of slide in power point [Single
Correct] [1 Marks]

1) Vertical

2 ) @Landscape

3 ) Portrait

4 ) None of above

Explanation :

Bloom's Level: Remember, Understand

26 ] Question : what is defined by the handout master? [Single Correct] [1 Marks]
1) Slide formatting

2 ) @Layout of audience handout notes

3 ) Handout content formatting for Microsoft word export

4 ) All of above

Explanation :

Bloom's Level: Remember, Understand

27] Question : What is term used when a clip art images changes the direction? [Single Correct] [1
Marks]

1) Group

2 ) Flip

3 ) ©Rotate

4 ) All of the above

Explanation :

Bloom's Level: Remember, Understand



28] Question : Which of the following factures should be you use when typing in notes text box?
[Single Correct] [1 Marks]

1) Slide show

2 ) Insert

3 ) Slide master

4)©@Zoom

Explanation :

Bloom's Level: Remember, Understand

29 ] Question : Which of following should be used when you want to add a slide to an existing
presentation? [Single Correct] [1 Marks]

1) File, add a new slide

2 ) @Insert, New slide

3 ) File Open

4 ) File, New

Explanation :

Bloom's Level: Remember, Understand

30 ] Question : To activates the previous cell in a pre -selected range, press [Single Correct] [1 Marks]
1) The Alt key

2 ) The Tab key

3 ) The Enter key

4 ) ©None of the above

Explanation :

Bloom's Level: Remember, Understand

Marks distribution as per Bloom's level

4]
e
3
1

Bloom's Linked Marks  Percentage
Level Question Count
Create 1 1 3.33

- Evaluate 0 0 0.00
Analyze 0 0 0.00

Apply 0 0 0.00



Bloom's Linked Marks  Percentage

Level Question Count
Understand 13 13 43.33
Remember 22 22 73.33

NOTE : Percentage for each Bloom's level is calculated using following formula

Percentage = ( Marks per Bloom's level / Total marks of all questions ) * 100
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Pharmaceutical Quality Assurance [2021-22]
Title : Computer Application (Second Sessional Exam 2021-2022)
Subject : Computer Application - Theory
Faculty : Ms. R. D. Buke
Year : First Year - First Semester
Date : Mon 04 Apr, 2022
Marks : 30
Duration : 60 Minutes

1] Question : Search engine are used to [Single Correct] [1 Marks]

1) Software system that is designed to search for information on the World Wide Web
2 ) Search Documents

3 ) Search Videos

4 ) @Al of these

Explanation :

Bloom's Level: Remember, Understand

2] Question : which is the short cut key of highlight the entire column [Single Correct] [1 Marks]
1)Ctri+ C

2 ) Ctrl+Enter

3 ) Ctrl+ Page up

4 ) @Ctrl+ Space bar

Explanation :

Bloom's Level: Remember

3 ] Question : In the formula, which specifies the fixed columns or row? [Single Correct] [1 Marks]
1)O% )

2)*

3)&

4)%

Explanation :

Bloom's Level: Remember, Understand

4] Question : Excel displays the current cell address in the [Single Correct] [1 Marks]
1) Formula bar

2 ) status bar

3 ) ©Name bar

4 ) Title bar

Explanation :



5] Question : Which of the following is not a term of Ms- Excel? [Single Correct] [1 Marks]
1) Cell

2 ) Columns

3 ) Row

4 ) @Documents

Explanation :

Bloom's Level: Remember

6] Question : What are the tabs that appear at the bottom of each workbook called? [Single Correct] [1
Marks]

1) Reference tabs

2 ) position tabs

3 ) Location tabs

4 ) ©@Sheet tabs

Explanation :

Bloom's Level: Remember

7 ] Question : The Cancel and Enter buttons appear in the [Single Correct] [1 Marks]
1) Title bar

2 ) @Formula bar

3 ) Menu bar

4 ) Sheet bar

Explanation :

8] Question : You can activate a cell by [Single Correct] [1 Marks]
1) Pressing the tab key

2 ) Clicking the cell

3 ) Pressing an arrow key

4 ) @Al of the above

Explanation :

9] Question : Ho do you inserts a row? [Single Correct] [1 Marks]

1) @Right-click the row heading where you want to insert the new row and select Insert from the
shortcut menu

2 ) Select the row heading where you want to insert the new row and select Edit >Row from the menu

3 ) Select the row heading where you want to insert the new row and click the Insert Row button on the
standard toolbar

4 ) All of the above

Explanation :

10 | Question : How can you print three copies of a workbook? [Single Correet] [1 Marks]

1) Select File > Properties form the menu and type 3 in the Copies to print text box

2 ) @Select File > Print from the menu and type 3 in the Number of copies text box

3) Click the Print button on the standard toolbar to print the document then take it to Kinko’s and have 2 more
copies made

4 ) Press Ctrl+P+3



Explanation :
Bloom's Level: Remember

11 ] Question : How do you delete a Column? [Single Correct] [1 Marks]

1) Select the column heading you want to delete and select the Delete Row button on the standard toolbar
2 ) Select the column heading you want to delete and select Insert Delete from the menu

3 ) Select the row heading you want to delete and select Edit>Delete from the menu

4 ) @Right click the column heading you want to delete and select delete from the shortcut menu
Explanation :

Bloom's Level: Remember, Create

12 ] Question : Which of the following is correct meaning of URL? [Single Correct] [1 Marks]
1) User Requisition Link

2 ) @Uniform resource locator

3 ) Uniform requisition link

4 ) Uniform resource language .

Explanation :

Bloom's Level: Remember

13 ] Question : Which one of the following is not a search engine? [Single Correct] [1 Marks]
1) Bing

2 ) Google

3 ) Yahoo

4 ) @Windows

Explanation :

Bloom's Level: Remember, Understand

14 ] Question : Full form of HTML is: [Single Correct] [1 Marks]
1) ©@Hyper Text Markup Language

2 ) Hyper Text Manipulation Language

3 ) Hyper Text Managing Links

4 ) Hyper Text Manipulating Links

Explanation :

15] Question : Moving from one website to another is called : [Single Correct] [1 Marks]
1) Downloading

2 ) ©@Browsing

3 ) Uploading

4 ) Attachment

Explanation :

16 ] Question : In which view Headers and Footers are visible? [Single Correct] [1 Marks]
1) Normal View

2 ) Page Layout view

3 ) ©Print Layout View

4 ) Draft View



Explanation :
Bloom's Level: Remember

17 ] Question : Which functioning Excel checks whether a condition is true or not ? [Single Correct] [1
Marks]

1) SUM

2 )COUNT

3)QIF

4 ) AVERAGE

Explanation :

Bloom's Level: Remember

18] Question : Symbol used at the beginning of the HREF text is [Single Correct] [1 Marks]
1)OHf

2)%

3)&

44

Explanation :

19] Question : Which of the following is a correct format of Email address? [Single Correct] [1 Marks]
1 ) name@website@info

2 ) ©name@website.info

3 ) www.nameofebsite.com

4 ) name.website.com

Explanation :

Bloom's Level: Remember

20] Question : A Web page is. [Single Correct] [1 Marks]
1) Made up of text and HTML tags

2 ) marked by an opening HTML tag <HTML>

3 ) marked by closing HTML tag</HTML>

4 ) @AIl of these

Explanation :

21] Question : Which protocol provides e-mail facility among different hosts? [Single Correct] [1 Marks]
1)FTP

2 )©@SMTP

3 ) TELNET

4 ) None of these

Explanation :

Bloom's Level: Remember, Understand

22] Question : in how many generation a computer can be ciassified [Single Correct] [1 Marks]
1)3

2)4

3)D5



4)6
Explanation :
Bloom's Level: Remember, Understand

23] Question : The file extenction of Ms-word documents in office 2007 is------ [Single Correct] [1 Marks]
1)doc

2 ) @docx

3) .pdf

4 ) txt

Explanation :

Bloom's Level: Remember, Understand

24 ] Question : which of the following section does not exist in a slide layout? [Single Correct] [1 Marks]
1) Titles

2 ) Lists

3 ) Charts

4 ) @Animations

Explanation :

Bloom's Level: Remember, Understand

25] Question : Which of following is the default page setup orientation of slide in power point [Single
Correct] [1 Marks]

1) Vertical

2 ) ®Landscape

3 ) Portrait

4 ) None of above

Explanation :

Bloom's Level: Remember, Understand

26 ] Question : what is defined by the handout master? [Single Correct] [1 Marks]
1) Slide formatting :

2 ) @Layout of audience handout notes

3 ) Handout content formatting for Microsoft word export

4 ) All of above

Explanation :

Bloom's Level: Remember, Understand

27 ] Question : What is term used when a clip art images changes the direction? [Single Correct] [1
Marks]

1) Group

2 ) Flip

3 ) @Rotate

4 ) All of the above

Explanation :

Bloom's Level: Remember, Understand



28] Question : Which of the following factures shouid be you use when typing in notes text box?
[Single Correct] [1 Marks]

1) Slide show

2) Insert

3 ) Slide master

4)@Zoom

Explanation :

Bloom's Level: Remember, Understand

29 ] Question : Which of following should be used when you want to add a slide to an existing
presentation? [Single Correct] [1 Marks]

1) File, add a new slide

2 ) @Insert, New slide

3 ) File Open

4 ) File, New

Explanation :

Bloom's Level: Remember, Understand

30 ] Question : To activates the previous cell in a pre -selected range, press [Single Correct] {1 Marks]
1) The Alt key

2 ) The Tab key

3 ) The Enter key

4 ) ©None of the above

Explanation :

Bloom's Level: Remember, Understand

Marks distribution as per Bloom's level

)
i
1

Bloom's Linked Marks  Percentage
Level Question Count

Creaie 1 1 3.33
Evaluate 0 0 0.00
Analyze 0 0 0.00

Apply 0 0 0.00



Bloom's Linked Marks  Percentage

Level Question Count
Understand 13 13 43.33
Remember 22 22 73.33

NOTE : Percentage for each Bloom's level is calculated using following formula

Percentage = ( Marks per Bloom's level / Total marks of all questions ) * 100



Dayanand Education Society's, Dayanand College of Pharmacy, Latur

Result Analysis

Subject: Computer Application ( First Semester )
Faculty: Ms. R. D. Buke /

Total(130.00)

Roll Computer Application Computer Application Computer Application
No. ( First Sessional (Second Sessional (Winter Home
Exam 2021-2022) Exam 2021-2022) Examination 2021-2022)

Student 2022-02-14 2022-04-04 2022-04-27
Name Signature Marks-30 Marks-30 Marks-70

01 Swapnali 25 27 62 114
Dalmade

02 Mayuri 25 24 64 113
Gatate

03 Mohini 29 24 62 115
Gotmukale

04 Pooja Kale 26 27 62 115

05 Pranav 28 27 60 115
Kauthekar

06 Bhushan 26 25 58 109
Palaskar

07 Saurabh 27 27 64 118
Rahatkar

08 Aishwarya 23 25 62 110
Rudrawar

09 Sushant 27 25 66 118
Sakhare

10 Dipak 27 24 66 s
Shinde

" Bhushan 27 25 66 118

Thengil
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Dayanand Education Society's, Dayanand College of Pharmacy, Latur

Result Analysis

Subject: Computer Application ( First Semester)
Faculty: Ms. R. D. Buke /

Total(130.00)

Computer Application Computer Application ~ Computer Application

Roll . . . .
N ( First Sessional (Second Sessional (Winter Home
0. S
Exam 2021-2022) Exam 2021-2022) Examination 2021-
2022-02-14 2022-04-04 2022)

Student Marks-30 Marks-30 2022-04-27
Name Signature Marks-70

01 Pavan 29 27 62 118
Chavan

02 Pramod 27 28 62 17
Dala

03 Shweta 27 25 64 116
Eklinge

04 Megha 25 28 66 119
Gaikwad

05 Vaishali 28 28 68 124
Gutte

06 Ajay Hole 26 26 60 112

07 Krishna 28 28 66 122
Kadam

08 Narayan 26 26 60 112
Kote

09 Sayali Mane 29 28 64 121

10 Muskan 26 28 64 118
Mujjawar

11 Bhagyashree 27 27 66 120
Pande

12 Anjali 27 27 60 114
Sabane

13 Mukan 26 26 64 116
Shaikh

14 Shradha 28 27 62 117
Solat

15 Pratiksha * 29 28 62 119
Surwase

16 Deepali 28 28 66 122

Swami



STUDENTS ANALYSIS -

@ Excelilent
Category Range Graph ColorTotal Students
Excellent Above 80% Blue 16
Good Between 61% to 80% Green 0
Average  Between 51% to 60%  Orange 0
Below Average Below 50% Red 0
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Dayanand Education Society's

DAYANAND COLLEGE OF PHARMACY,

Barshi Road, Latur (Maharashtra) Pin - 413531 PH-(02382)-223299, 223199

principaldcop@email.com

J

CERTIFICATE COURSE ON “Computer Application”
FEEDBACK FORM (2021-22)

Name of Student : <SabnN€ ija”a Ambadas

M phaym  Cphavmgceutics)

Class
Phone No. . 93113185150
E-mail ID ._anjali sabn 1997 (D 9gmai. om .
Feedback:
Sr. Parameter Excellent (\;7531 Good Average
1 Course objective were stated —
clearly
2 Participation & interaction were o
encouraged
3 This content was organized & easy —
to follow
4| Duration of course was sufficient —
5 The presenter prov1deq -
adequate time of question
&Answered them satisfactorily
6 | The course increased my
knowledge & skills b=
7 The presenter & presentation was J
effective

S

Signature




Dayanand Education Society's

DAYANAND COLLEGE OF PHARMACY,

Barshi Road, Latur (Maharashtra) Pin - 413531 PH-(02382)-223299, 223199

Website: www.dayanandpharmacy.org E-mail : dayanandpharmacy@rediffinail.com

principaldcop@gmail.com

/

List of students completed for certificate course on Computer
Application
M. Pharm-I 2021-22

Pharmaceutics & Quality Assurance

I e e R o
1 Chavan Pavan Bharat 1 Delmade Swapnali Shivaji
2 Dalal Pramod Shivanand 2 Gatate Mayuri Satishappa
3 Eklinge Shweta Shivraj 3 Ghotmukle Rohini Ashokrao
4 Gaikwad Megha Virsen 4 Kale Pooja Prabhakar
3 Gutte Vaishali Pundlik 5 Kauthekar Pranav Venkat
6 Hole Ajay Ramdasrao 6 Palskar Bhushan Anandrao
7 Kadam Krishna Baliram 7 Rahatkar Saurabh Sainath
8 Kote Narayan Rajaram 8 Rudrawar Aishwarya Santosh
9 Mane Sayali Dadasaheb 9 Sakhare Sushant Digambar
10 Mujawar Muskan Dildar 10 Shinde Dipak Narsing
11 Pande Bhagyashree Nagorao 1 Thengil Bhushan Tukaram
12 Sabane Anjali Ambadas
13 Shaikh Muskan Ajaz
14 1 Solat Shraddha Adinath
15 Surwase Pratiksha Suresh
16 Swami Deepali Mallikarjun
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DAYANAND EDUCATION SOCIETY'S

DAYANAND COLLEGE OF PHARMACY

Barshi Road, Latur - 413512 Maharashtra. Ph:- 02382-223199.

CERTIFICATE
OF PARTICIPATION

This is to certify that Mt./Ms._Graikwad Km%m,m...r\\..ﬁml%.. ..... Student

of Dayanand College of Pharmacy, Latur studying in class M. Pharm

4
[/11/111/IV has successfully completed a Certificate Course on Computer

.}
)\MA.WW!
—e

D

Dr. Satpute K.L.
Principal
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